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About Control
While collections of forms await each successive processing step in the eFLOW workflow, they are stored
temporarily in collections composed of digital images and accompanying text data. The Control module
enables you to monitor these collections, showing you their status at the different stations. It helps you to
detect problems and bottlenecks in the processing workflow, and resolve them.

Open Control
To open the Control module, in eFLOW Launch Pro, in the Reports list, select Control.
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Control desktop
After you open Control, the main window is displayed.

The Control main window provides access to five different views. Click on a view name to open that view.
In the Application list, select the application you are interested in. You can also select an application flow to
view only information for that flow. These settings apply for all views, with the exception of the Domain view,
which lists all applications.
n

The Workload view provides a general overview of the status of all stations and collections in the
selected application.

n

The Collections view displays the status of all collections in the selected application.

n

The Stations view displays the status of all active stations and users in the selected application.

n

The Viewer view provides an overview of overall system usage and progress for the selected application.

n

The Domain view provides for each active application an overview of the number of active stations, and
the status of the server.
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Which information appears in the display area depends on the selected view. Click the Refresh button
to update the view with the latest information.

Workload view
The Workload view provides a general overview of the status of all stations and collections in the selected
application.

Workflow diagram
The upper part of the screen provides a graphical overview of the stations in the application workflow.

Station icons
The icon in the upper right hand corner of each station indicates the station's status:
n

Green - Running: The station is currently processing collections.

n

Yellow - Idle: The station is currently not processing collections.

The number of collections and forms awaiting processing (the station 'queue') is displayed below the station:
For example, 1/7 indicates one collection and seven forms.
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Station load bar
The load bar below the station indicates the number of collections in the station queue compared to the
queue threshold. The queue threshold specifies the maximum number of forms allowed in the station queue
at one time. See Queue thresholds for information on configuring queue thresholds.
The load bar can help you to quickly identify when stations are overloaded. If the load bar shows red, you
should take action, for example, add more automatic station instances or manual operators to process the
queue.
n

When there are no collections in the queue, the load bar is white.

n

As collections arrive and processing begins, the load bar changes from pure white to gray and white. The
white part represents the difference between the number of forms in the queue and the queue threshold,
and is an indication of how close to the threshold the number of forms is. The less white, the closer the
threshold.

n

When the number forms is very close to the threshold, the load bar takes on a gray pattern.

n

As the threshold is exceeded, the load bar starts to turn red.

n

The further the threshold is exceeded, the more red is shown in the load bar.

Reject and Pending
A collection may be moved to the Reject or Pending queue if there is a problem with the collection or its
routing through the workflow.
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Collections in the Reject queue are usually corrupted in some way. You must investigate and fix the
problem. You may have to delete the collection and re-import it.
Collections are most often transferred to the Pending queue if routing to the next station fails. You must
investigate and fix the problem, then send the collection into the workflow again. There may be an error in the
workflow configuration.

Collections table
To view the collections currently in a specific station, click on the station in the workflow diagram.
The collections are displayed in the Collections table. Each line in the Collections table represents one
collection waiting to be processed, or currently being processed, by the station. See Work with collections
for information on using this table.
Column

Description

Priority

Collections may have one of the following priorities:
High. You can raise the priority of a collection to ensure that it is processed before other
collections in the queue. By default, collections are assigned the priority Normal. When you
prioritize a collection, the priority changes to High. Collections with the priority High are
processed before all other collections.
Normal. This priority is assigned when a collection enters the system, or when you manually
restore the priority.
See Prioritize a collection for more information on prioritizing collections and restoring the
priority.

Collection

Collection ID. This uniquely identifies the collection in the system.
Collection IDs are usually assigned automatically by eFLOW, but you can override this by
checking the Keep Batch Name option in the flow properties in the eFLOW Design module.
See the eFLOW Design User Guide for more information.

Flow

The name of the flow to which the collection belongs. If you selected a specific flow in the
toolbar Flow list, only collections belonging to this flow are displayed in the table.

Status

The status of the collection:
Locked: The collection is currently being processed by one of the station instances.
Available: The collection is awaiting processing.
Hold: The collection is on hold and must be released before it can be processed. See Hold
or release a collection for more information.
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Column

Description

Time in

The elapsed time, in hours, minutes, and seconds, since the collection entered the system.

System

If this time is larger than a predefined threshold, the time appears in red. You should
investigate why processing of the collection has not been completed after such a long time.
You can define this threshold in the configuration options.

User

For locked collections: Name of the user logged in on the station on which the collection is
locked.

Machine

For locked collections: Name of the machine running the station on which the collection is
locked.

Meta

Information about the collection and specific fields in the collection; for example,

Tags

CreationTime, AnyBadPagesOrForms, NumberOfForms. An application's meta tags are
defined in the eFLOW Design module. You can specify which meta tags to display in the
Collections table and the order in which they are displayed. See Modify meta tag columns
for more information.

Stations table
To view all workstations that are currently running a specific station, click on the station in the workflow
diagram.
The workstations are displayed in the Stations table. Each line in the Stations table represents one loggedin instance of the selected station.
Column

Description

Status

The status of the station:
Running: The station is currently processing collections.
Idle: The station is currently not processing collections.

User

Name of the user logged in on this station instance.

Machine

Name of the computer running this station instance.

Name
Station

Name of the eFLOW station.

Name
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Column

Description

Current

Current number of pages processed per minute in the station. This column has a red border if

PPM

the number is less than the minimum pages per minute specified in the configuration. See
Configure Control for more information.

Collections view
The Collections view shows all collections currently in the selected application. It is useful for locating a
specific collection within the application.
See Workload view for information on the Collections table and the workflow diagram.
To locate the position of a collection in the workflow, click on the collection in the table. The border of the
station in which the collection currently resides is highlighted in the workflow diagram.
To perform actions on a collection, right-click on the collection and select from the menu. See Work with
collections for more information.
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Stations view
The Stations view displays the status of all active stations and users in the selected application.

Each line in the Stations view represents one logged-in instance of the selected station. To filter the view,
click the arrow next to a column heading and select an entry from the filter list.
See Stations table for information on the columns displayed in this view.
To perform actions on a station, right-click on the station and select from the menu. See Work with stations
for more information.

Viewer view
The Viewer view provides an overview of overall system usage and progress for a selected application.
You can use this view to immediately spot problems with station thresholds. For example, if not enough
stations are working to perform recognition, the Viewer view display will indicate this. See Configure Control
for information on defining thresholds.
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Each line in the Viewer view represents a station of the selected application. To filter the view, click the arrow
next to a column heading and select an entry from the filter list.
Column

Description

Name

Name of the eFLOW station.

Status

Running: The station is currently processing collections.
Idle: The station is currently not processing collections.
Pending Logout: A logout request has been sent to the station, but log out has not yet been
completed. See Log out a station for more information.

No. of

Number of instances currently running this station. A station can run more than once, on one

Instances

or more workstations; each occurrence of the station is an instance.

No. of

Total number of forms in all instances running this station. If the total number of forms

Forms

exceeds the threshold value defined in the configuration, the field is marked with a red
border. See Queue thresholds for more information.

Current

Current average number of pages per minute processed by the station. If this figure is low,

PPM

you may want to add more automatic station instances or manual operators, or logout
station instances to release resources.
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Column

Description

Time Left

The estimated time remaining until the station has finished processing the collections, based

(min.)

on the current processing rate. For example, if the last collection took 1 minute to process
and there are still 12 collections in the queue, the Time Left will be 12 minutes.

Domain view
The Domain view provides an overview of the overall status of all active applications in the eFLOW domain.

Each line in the Domain view represents one application. The table contains the following columns. To filter
the view, click the arrow next to a column heading and select an entry from the filter list.
Column

Description

Name

Name of the eFLOW application.

ActiveStationsCount

The number of currently active station instances.

PrimaryServerState

The status of the primary server.

State

The status of the server.

eFLOW Control Module 5.2 User Guide

Page 13 of 24

Work with collections
This section explains how to work with the Collections table and how to perform various actions on
collections.
In the Workload view, the Collections table displays all collections in the currently selected station. In the
Collections view, the Collections table displays all collections in the currently selected application. See
Collections table for a description of the columns in this table.
Right-click on a collection in the Collections table to access a context menu that enables you to perform
actions on the collections.

Work with the collections table
Change the table height
Workload view only. Position the mouse cursor on the border above the table. When the cursor changes to a
crosshair , drag up or down to increase or decrease the table height.

Sort
Click on a column heading to sort the table by that column in ascending order. Click again to sort in
descending order. The icon indicates the current sort order:
Ascending
Descending
You can only sort the list by a single column.
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Search
To search for a collection, click the Find collection button

. In the Find collection dialog box, enter the

name of the collection, or part of the name, and click OK.

Filter
You can filter the Collections table to display only collections that correspond to the criteria you define.

Simple filter
Click the arrow next to a column heading and select an entry from the filter list.

Click (Custom) to create a custom filter. In the Custom AutoFilter dialog box, select from the lists to
construct your filter, then click OK.
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Advanced filter
The advanced filter enables you to filter by specific meta tags.
1. Click on the Set collections filter button

.

2. In the Collections Filter dialog box, enter a filter expression.

n

You can use any SQL syntax to formulate the filter query.

n

To display a list of the available meta tags, press CTRL + SPACE . Double-click on a meta tag to add it
to the expression.

n

Enclose string values in single quotations marks.

n

For meta tags that use a check box, use the values 'True' (check box checked) or 'False' (check box
unchecked) in the expression. For example, AnyBadPagesOrForms = 'True'.

n

To specify more than one condition, enclose each condition in parentheses and connect them with
AND or OR. For example, (NumberOfForms >= 4) AND (AnyBadPagesOrForms = 'True').

n

If your filter syntax is incorrect, an error message is displayed.

3. Click OK.

Clear a filter
The current filter is displayed above the Collections table. To clear the filter and display all collections again,
click the Clear Filter

button.
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Previous filters
When you use the simple filter, the current filter and any previous filters you have set (simple or advanced) are
available below the Collections table.

To clear the current filter, clear the check box.
To use a previous filter, click on the arrow and select the filter from the list.

Modify meta tag columns
You can specify which meta tags to display in the Collections table and the order in which they are
displayed.
1. Click the Modify columns button

.

2. In the Modify Collection Columns dialog box, select meta tags in the Available Meta Tags list or the
Visible Meta Tags list, then click one of the buttons between the lists to transfer them to the other list.

To restore the default settings, click the Reset button.
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3. To change the display order of the meta tags, select a meta tag and click the Move Up
Down

or Move

button.

4. Click OK.

Select collections
With the exception of viewing a collection's image, you can perform all collection actions on one or multiple
collections.
n

Single collection: Click on the collection in the Collections table.

n

Multiple collections: Click on the first collection, then hold down SHIFT or CTRL and click on the other
collections.

n

All collections in the list: Right-click in the list and select Select All.

View collection images
To view the images of a collection, right-click on the collection and select

View Collection.

The images are displayed in the Image Viewer. Use the menu or the buttons at the top of the viewer to work
with the images. Position the mouse cursor over a button to view a tooltip showing the button's purpose.

Move a collection
You can move a collection by dragging and dropping it from the Collections table to one of the stations in
the workflow diagram, provided the collection is in a compatible format. For example, you can drag
collections from the Validate or Deliver station back to the Recognize station, but you cannot drag and drop
collections to and from the Scan and Collect stations.
You cannot move locked collections, that is, collections that are currently being processed.

Prioritize a collection
You can raise the priority of a collection to ensure that it is processed before other collections in the queue.
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By default, collections are assigned the priority Normal. When you prioritize a collection, the priority changes
to High. Collections with the priority High are processed before all other collections.
Collections retain their priority when they pass to the next station. You cannot prioritize locked collections.
n

To raise the priority to High, right-click on the collection and select Prioritize.

n

To return the priority of the collection to Normal, right-click on the collection and select Restore priority.

n

To raise or restore the priority of all collections in the selected application, in the Station menu, select
Prioritize All Collections or Restore All Collections Priority.

Hold or release a collection
You can hold a collection to pause processing of that collection. Processing of the collection stops, but
processing of other collections in the queue continues. You cannot hold or release locked collections.
n

To hold a collection, right-click on the collection and select

Hold.

n

To resume processing of a collection that is on hold, right-click on the collection and select
Release.

n

To hold or release all collections in the currently selected application, in the Station menu, select Hold All
Collections or Release All Collections.

Note: Held collections are displayed at the bottom of the Collections table.

Delete a collection
You cannot delete locked collections.
To delete a collection, right-click on the collection and select

Delete, then click OK to confirm the

deletion.
To delete all collections in the currently selected application, in the Station menu, select Delete All
Collections, then click OK to confirm the deletion.
Note: In the Workload view, Delete All Collections applies only to the currently selected station.

Export and import collections
You can export collections to a file, for example, to move them to another environment for testing or support
purposes. The file has the extension .Dynamic. You can only import collections into the same application
(that is, the same CAB) from which they were exported. The collections are imported to the same station
queue from which they were exported.
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n

To export a collection, in the Workload view, select the collection, then right-click and select Export to
Archive. Enter a file name and click Save.

n

To export all collections in the currently selected application, select the menu item File > Export
Dynamic to Archive. Enter a file name and click Save.

n

To import collections, select the menu item File > Import Dynamic Archive. Select the file and click
Open.

Work with stations
This section explains how to work with stations.

Add a station instance to a queue
You can add additional instances of automatic stations, such as Recognize or Deliver, to spread the
processing load and thus avoid bottlenecks in the workflow.
1. In the Workload view, double-click on the station.
2. In the Login Station dialog box, select the machine on which the instances should run and the number of
instances to add.
3. Click Run Now.

Log out a station
In the Stations view, right-click on station and select one of the Logout Station options:
Option

Description

Request

The station logs out after completing the current operation. It completes processing of

Orderly

the current collection, puts the collection to the server, then shuts down.

Logout
Request
Immediate
Logout

Applies only for automatic stations.
The station attempts to abort the current operation and shuts down immediately.
Applies only for automatic stations.

Disconnect

The station is disconnected from the eFLOW server. It may continue working for a

From Server

while, but it is not able to put the collections back to the server.
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Send a message to a station
To send an instant message to users of manual stations, in the Stations view, right-click on the station
instance and select Send message.
The station will receive the request and display the message to the user in a dialog box.

View station properties
In the Stations view, right-click on the station and select Properties.
The Process ID is the PID of the process that is displayed in the Windows Task Manager in the Details tab.
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Configure Control
To change the configuration settings, click the Configure button on the toolbar

, or select the menu item

Options > Configure.
The Controller Options window opens.

Click the Reset button to restore the settings to their default values. This restores the settings in all tabs.
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General options
Option

Description

Collection

Specifies the maximum time in hours that a collection may remain in the system without

time in the

the user being alerted. When a collection is in the system longer than the specified time,

system

the collection's Time in System value turns red in the Collections table to alert the user.

threshold
(hours)
Number of

Specifies the total number of collections that the system may handle at any time. When

collections in

this threshold is reached, an error message is displayed when new collections are

system

imported, but this does not prevent the import of the collections.

threshold
Maximal

Specifies the maximum number of collections to display in the Collections table.

collection
query size
Automatic

Specifies how often the information displayed in the Control views is updated, in

refresh

seconds.

interval (sec)

Queue thresholds
Option

Description

Station

Name of the eFLOW station.

Max

Specifies per station how many forms may be held in the queue of that station. If this threshold

Forms
In

is exceeded, the station's No. of Forms value is highlighted red in the Viewer view. The
station's load bar also indicates how close to this threshold the queue load is. See Station load

Queue

bar for more information.

Min

Specifies per station the minimum number of pages to be processed per minute. If this

PPM

minimum is not reached, the station's Current PPM value is highlighted red in the Stations

(pages

view and the Viewer view.

per
minute)
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Session thresholds
Option

Description

Station

Name of the eFLOW station.

Min PPM (pages per

Specifies the minimum number of pages to be processed per minute by each

minute)

station instance.

Min Speed

Specifies the minimum activity speed expected for each station instance. Rate
units are station-specific, for example, forms per minute, or typed characters
per minute.
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